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DEFINIZIONI E ACRONIMI

«NTP» NTP Nano Tech Projects SRL.

«NED.Micro.DH» Nano Eye Device per Ematologia Digitale.

«NED.Micro.DP» Nano Eye Device per Patologia Digitale.
«AF» Autofocus.

«FHD» Monitor ad alta definizione.

«HD» Alta Definizione.

«Real-Time Image» Immagine in tempo reale.

«Path» Percorso.

«Virtual Slide» Vetrino virtuale.

NED.MICRO.DP






Introduzione - )

1- Procedura di utilizzo NED.Micro in localer:9)
2- Procedura di utilizzo NED.Micro in remotor-q 25
Famiglia NED: - 20)

I N D I C E ACCeSSOFi(Pag.BZ)

Informazioni Utilir.q 22

Annotazioni g4

NED.MICRO.DP )




Utilizzo del sistema NED.MICRQO in locale Procedura di utilizzo del sistema NED.MICRO in remoto

pag. pag.
Come espellere il portavetrini.......cccoviiiiciiiin 10 Master 0 VIEWET ..ottt 26
Come scansionare i VEtrini ......ccoceeiieieieneieieccee 11 Salvare una porzione d'immagine in HD ..........c.ccoe.... 27
Come spostarsi nel Vetrino ..., 12 Come condividere disegni tra Master e Viewers ........... 28
Come cambiare Vetrino ..o 13

Come cambiare l'intensita del led ... 14

Come cambiare obiettivo ..o, 15

Come mettere a fuoCo ..o 16

Come vedere la lente d'ingrandimento digitale ........... 17

Come regolare l'immagine ..........cocooii 18

Miscellan@o ... 19

Come tornare alla situazione iniziale...........cccooiinn. 20

Come scattare e salvare un'immagine.......c.cocccoovveennn. 21

Come inserire disegni e annotazioni...................... 22

Come chiudere il programma ......ccccoovviiiiiiniiin 23



INTRODUZIONE

La rivoluzione digitale in anatomia patologica

NED-DP rappresenta |'ultima generazione di strumenti che consentono di ottimizzare i
processi di connessione tra ospedali remoti. La condivisione delle immagini diagnostiche in
tempo reale su una rete dati locale e geografica rappresenta la nuova frontiera della
telemedicina.

Il controllo remoto del NED-DP e |'alta definizione delle immagini consentono di formulare
una diagnosi urgente con precisione e con la possibilita di avere un secondo parere. Grazie
alla versatilita del nuovo strumento NED-DP, |'accesso alle immagini diagnostiche diventa

pit veloce ed efficace.

Il controllo remoto completo facilita la consultazione e la refertazione remota del campione
istopatologico.

CE - IVD CERTIFICATO (Regolamento(UE) 2017/746)
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COME ESPELLERE IL PORTAVETRINI?

Premere il bottone «Open» ubicato in cima al menu
laterale destro al di sopra del portavetrini.

Oppure, direttamente premendo il bottone
dedicato sul pannello frontale del case

Per far rientrare il portavetrini basta metterlo in posizione e
sara rilevato automaticamente.

Se l'opzione automatica e disabilitata, bastera cliccare
nuovamente i pulsanti descritti sopra.

o, wEd wd

Alla chiusura dell'applicazione il
sistema chiedera per sicurezza se
si vuole espellere il portavetrini.

NED.MICRO.DP
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COME SCANSIONARE | VETRINI?

Premere il bottone “Scan Checked"” dell'elemento 1"‘, e
"Menu Minimaps Side Bar" per scannerizzare tutti i etes
vetrini (cliccare il pulsante raffigurante il pennello se
si vuole scannerizzare un singolo vetrino alla volta.
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@ Se si passa con il mouse sopra il vetrino
scannerizzato si visualizzera la macromappa
a fianco, attivando I'opzione dedicata si puo

L 8 , L
st lasciare sempre visibile.
ot Lk -

Please wait until preview...

Per cancellare le scannerizzazioni si dovra
cliccare il bottone «Clear All»
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COME SPOSTARSI NELVETRINO?

Premendo il pulsante sinistro del mouse e tenendo premuto, ci si puo XY Movements
spostare trascinandolo nella direzione desiderata, o tramite gli appositi A
pulsanti del «<Menu XY Moves Side Bar»

A= =

: PATHOLOGY | & User v | File = | Options =| View » Guide - | Advanced = Administrator = |§‘C0nnecl

PROCEDURA DI UTILIZZO DEL SISTEMA NED.MICRO IN LOCALE

| . .. .
e o @ Altri metodi di spostamento, se sono attive le
Mouse Moves , varie opzioni, sono la tastiera (tramite le
e : T s frecce e ai tasti «A-S-D-W»), il Joystick oppure
EYs C v otkeys Activate . . .
Minimaps 3 [rr—r— il tastierino esterno (Keypad)
Macroma 3
Save PicluF:e , Autematically activate hotkeys on startup
g:‘t_o{c:._cm : PATHOLOGY | & User = | File » | Options =| View = Guide = ‘ Advanced » Administrator « |QConned |
. Right Mouse Click Action  »
Interface Language b A — R
[ Joystick v (7] toystick Activate
Hot Keys Shortcuts 3 Show Joystick Layouts
Minimaps ' Mode Layout 1
Mac"’f“a" ' Mode Layout 2
Save Picture 3 Mode Layout 3
Autofocus 3 Mode Layout 4

NED.MICRO.DP 18




COME CAMBIARE VETRINO?

0~ 0 -
Premere con il tasto sinistro del mouse sopra la minimappa i __
del vetrino che si vuole visualizzare, oppure, se attive le 7 o | —ﬁ-
opzioni, i tasti rapidi con la tastiera («<F1-F2-F3-F4») , i bottoni _ : .
del Joystick associati a tale funzione, o in fine, i tasti del o
Keypad.

Hotkeys Layout
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Objective ] -® s
Objective [ -@ O | ==

D Show/Hide Macromap
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Premendo il tasto sinistro del mouse su un punto della
barra del «Menu Light Side Bar» oppure tenendo
premuto e spostando l'indicatore della barra stessa.

N
S [J
IS o

Light (20.0%)

0

Altri metodi di regolazione dell'intensita del
led sono la rotella del mouse dopo aver
selezionato la barra e, se sono attive le varie
opzioni, la tastiera (tramite i pulsanti «<Home»
e «End»), il joystick premendo gli appositi
bottoni oppure, i tasti del Keypad.

PROCEDURA DI UTILIZZO DEL SISTEMA NED.MICRO IN LOCALE
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COME CAMBIARE OBIETTIVO?

Premere sul bottone relativo all'obiettivo che si desidera
utilizzare nel «Menu Objectives Side Bar».

Se le opzioni sono attive & possibile cambiare obiettivo
anche tramite tastiera (Tasti dall'1 al 6) e tramite joystick.

Inoltre, € possibile cambiare obiettivo tramite click destro
del mouse se l'opzione ¢ attiva.

PATHOLOGY | © User [ | File ~| Options +| View + Help ~ | Advanced « Administrator ~ | ¥ Connect ‘m )
Mouse Moves

Joystick

Hot Keys Shortcuts

External Keypad STREAMDECK

Minimaps

Center on Click
— [

| None
Autofocus
Take a Picture
Go to the Next Objective
Go to the Previous Objective

v w w w w w |w
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Se l'utente clicca nuovamente nello stesso
obiettivo modifichera la velocita di messa a
fuoco (asse Z) da micrometrica (colore verde)
a macrometrica (colore arancione)



COME METTERE A FUOCQO?

2
O
9
=
O
3]
>
[a)
E’ possibile mettere a fuoco muovendo la rotellina del Y S
. . . . . - -
mouse all'interno dell'area dell'immagine principale, o in -
alternativa premendo i bottoni «su» e «giu» del menu focus. o $ 2000| 2
O
=
-]
, . . ,- . . 5
E' possibile mettere a fuoco I'immagine automaticamente premendo :
Auto .
Focus I'apposito bottone «Auto Focus». &
O

t PATHOLOGY | & User + | File - |°P“°';g;l‘;:“ c‘:;ﬁ' ""“‘:“Te" . ‘:"“‘i““‘““" 2 |8 Connedt | @ Altri metodi di regolazione del fuoco sono, se sono
Mouse Moves N Autofocus attive le varie opzioni, la tastiera (tramite i pulsanti
Joystick b | Takeapicture «Page Up» e «Page Downy), il Joystick ruotando orario
im0 | SemmtheNat Otpcie o antiorario il pomello, oppure i tasti del Joypad.
inimaps k Go to the Previous Objective

Si puo lanciare l'autofocus con il tasto «F» della
tastiera, con il tasto destro del mouse se le opzioni
sono attive oppure con il tasto del Joypad.

NED.MICRO.DP 17




COME VEDERE LA LENTE D'INGRANDIMENTO DIGITALE?

Premere nell'icona «Digital Zoom». Zoom | Camera | Miscelaneous
Trascinando la barra si puo scegliere il fattore di

- (- . Digital Zoom (1.00 x)
magnificazione dello zoom. @

Una volta settato e attivato il «Digital Zoom» bastera tenere
premuto e muoversi sopra lI'immagine principale per osservare
in corrispondenza del mouse la lente d'ingrandimento.

FTVOOT NI OdDIW 'A3IN VINILSIS 13d OZZI17ILN Id Y4NA3ID0dd

of e &5

e @ Se rilascio il tasto del mouse lo zoom digitale
reresa non & piu visibile ma rimane attivo; per
disattivare la funzione in modo permanente
e occorre cliccare nuovamente sull’icona.
T T

2 2

I it

nmt 4 X’VMD@VEM::S
o ¥ L EER 7
—
Q Digttal Zoom (3.00 x) .
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COME REGOLARE L'IMMAGINE?

9
Z
©)
S
=
o o
Zoom CEMETE  Miscslaneous Camera Control Panel : %
Per aprire l'interfaccia dei parametri della wmw”‘“@ - . s
telecamera occorre cliccare il titolo della scheda o B e z
: : : B =
«Camera» e, al suo interno, cliccare sull'icona 2
- " 1960693 ()
«Camera Control Panel» T . S
CameraProfile\preset DEFAULT pfs e M”w""ea"‘a"ce P |EI
CameraProfile\preset_tuttoZERQ.pfs Delere i)
Nell'interfaccia di modifiche parametri & possibile = o | <
caricare anche dei preset gia esistenti (che RS 3
o (e . . A oL o S O
possono essere a loro volta modificati, salvati o . b 2

Cancellati) o crearne di nuovi. s

Co:;;djugmems GREEN BLUE
‘p'esd_m ‘ ) Hue: Sa-tumm-n X Hua: 'Sa-luratin-n : Hus: Sa-tumtitfn

amTs (SR 1ot s (I Lo -acwso R 100
CYAN MAGENTA
Hue  Saturation Hue  Saturation

Ad ogni modifica dei parametri la telecamera si aggiornera in real-time e

I'utilizzatore potra vedere nell'immediato le variazioni effettuate. - -
S : o AL G LA LES BRI L3 S
Nel panello «Camera» si puo vedere il preset attivo in quel momento. .

Color Compensation

NED.MICRO.DP 19




MISCELLANEOUS

Il bottone «Show Crosshair» permette di vedere una croce
sull'immagine in real-time come riferimento centrale. +

Show Crosshair Picture Select Picture
Explorer Save Folder

Il bottone «Picture Explorer» apre la finestra per gestire sia le cartelle
che i file d'immagine salvati.

Il bottone «Select Picture Save Folder» apre la finestra per selezionare la
cartella dove salvare le immagini scattate (& possibile creare una nuova
cartella se necessario) quando l'opzione automatica € attiva.

FTVOOT NI OdDIW 'A3IN VINILSIS 13d OZZI17ILN Id Y4NA3ID0dd
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@ Per nascondere la croce basta cliccare
nuovamente nel bottone «Show Crosshair»
mentre per le altre due interfacce basta
chiuderle semplicemente la finestra.

- Create Folder ‘ ‘xrzm H oK
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COME TORNARE ALLA SITUAZIONE INIZIALE?

Al cliccare sul bottone «Reset all parameters» presente alla fine del menu
laterale destro, la posizione di fuoco si spostera verso quella default del
obbiettivo in funzione, inoltre, si resettera la luminosita sull'immagine e altri
parametri modificati dall’'utente. Tutto questo con il fine di lasciare I'immagine
nelle condizioni iniziali.

‘|, Beset all parameters

ihOlae /s -0 O0f o Ml-E- 8B =06
v T 3

COME INSERIRE DISEGNI E ANNOTAZIONI?

Attivare una funzione di disegno o di testo dal «<Menu Drawing Top Bar».
Dopo di che, utilizzando il mouse, cliccare e trascinare quest'ultimo per
inserire la funzione attivata.

PROCEDURA DI UTILIZZO DEL SISTEMA NED.MICRO IN LOCALE

L'utente puo disattivare le funzioni, cancellare i disegni e tornare al normale utilizzo dello
strumento cliccando il bottone «Pointer». Non & possibile spostare il campione in real-time
nel momento in cui & attivata una funzione di disegno.

NED.MICRO.DP 21



COME SCATTARE E SALVARE UN'IMMAGINE?

Per scattare un immagine occorre cliccare sul bottone «Take a Picture»
posizionato in mezzo nel menu laterale destro.

H©)

Se l'opzione automatica € attiva, I'immagine verra salvata automaticamente nella
cartella pre-scelta.

Se no, una volta acquisita I'immagine si aprira una finestra dove |'utente potra:

« scegliere formato, dimensione, nome, ecc... associati all'immagine;

» scegliere la cartella di destinazione salvataggio (oppure crearla).

* salvare 'immagine. -

“] Image Name:
[NED.Micro.lmage_202306271503232 |

FTVOOT NI OdDIW 'A3IN VINILSIS 13d OZZI17ILN Id Y4NA3ID0dd

Options.
Format Area Data

Si puo anche salvare I'immagine con i disegni effettuati sopra Owm Ouw | Ownws  puy
di essa, ma in questo caso occorre cliccare il bottone nel -

menu dei disegni.

hlo DL/ ma-loo-Oho-MlI-E- 8 =0I6

—_—
Create Folder X Cancel oK
+
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Per chiudere il programma selezionare il menu in alto nella voce «File» File | Options - View - Helf
e cliccare sul bottone «Exit». Eait

Se il portavetrini risulta inserito, il sistema mostra un messaggio prima
di chiudere il programma.

ideholder Inside X \
S @ L'utente pud:
o The Slideholder is still inside. Do you want to take it out? ¢ Cllccando Il bOttone «Cancel»’ annu”are |a Scelta dl
chiudere il programma.
= No Canea e Cliccando il bottone «Now, il sistema torna nell'interfaccia
principale.

e Cliccando il bottone «Yesy, il sistema mostra una finestra
di attesa e, dopo che il tecnico ha estratto il portavetrini e
reinserito, il sistema chiudera il programma.

PROCEDURA DI UTILIZZO DEL SISTEMA NED.MICRO IN LOCALE
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MASTER O VIEWER?

Si puod scegliere tra Master e Viewer nell'apposita
finestra. Se esiste gia un Master viene visualizzato il
nome all'interno della sezione e l'utente, se autorizzato,
puo accedere all'interfaccia come Viewer.

Se si accede come Master & possibile, per ogni utente,
scegliere se abilitarlo come Viewer.

PROCEDURA DI UTILIZZO DEL SISTEMA NED.MICRO IN REMOTO

Per accedere al sistema remoto € necessario

I"'utilizzo di un browser compatibile (Chrome, Edge,
Mozilla, Vivaldi, Opera, Brave, Torch, ecc...)

Se si accede come Master si pud controllare la
macchina da remoto altrimenti, come Viewer, si
puo solo vedere I'immagine e anotazioni.

—_——

NED.MICRO.DP
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SALVARE UNA PORZIONE D'IMMAGINE IN HD?

Se si desidera vedere I'immagine non compressa,
cliccare sul bottone «download HD image» nell’area
superiore del menu laterale destro.

[z OB: 6 A o
: . B B § [
1§ 5vfi Sl {

NED.MICRO.DP

[ @ Stop @ Open

Una volta selezionata una zona
dellimmagine in  real-time viene
mostrata senza compressione in un
quadro. E' possibile inserire dei segni
nellimmagine, decidere di salvarla,
oppure chiudere la finestra.




CONDIVIDERE UN PUNTO D'INTERESSE TRA MASTER E VIEWERS?

Tutti i disegni fatti dal Master vengono condivisi in tempo reale con i Viewers.

E @:= @

PROCEDURA DI UTILIZZO DEL SISTEMA NED.MICRO IN REMOTO

MASTER VIEWERS

@ Oltre ai disegni condivisi dal master, i Viewers vedono la posizione del master in
tempo reale, I'ingrandimento attualmente in utilizzo e il vetrino in osservazione.

NED.MICRO.DP 29
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Patologia Digitale Ematologia Digitale Rilevatore di Virus

...molteplici prodotti per molteplici applicazioni...

Visita www.ntpsrl.biz e troverai tutte le informazioni di cui hai bisogno.







ACCESSORI

Opzionali

Tastierino Esterno Joystick Monitor FHD
15 tasti interattivi XYZ (24"-42")
6 tasti DICOM Ready
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ANNOTAZIONI
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